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CB Electronics has developed a new software suite to interface its multi-machine control systems to
Windows compatible PCs.

At the heart of the new system is the CB Serial Port Server that allows up to eight applications to
access the serial port / Machine Control System at the same time. The serial port may be linked to
CB SR/MR systems or directly to a single Sony Protocol Machine.

Up to eight different CB Electronics software applications communicate via the server permitting the
use of multiple applications at the same time. 

• System Display
Ø Displays the status of all machines in the studio 
Ø Record track arming and display for each machine
Ø Offset and Sync Points
Ø Record In And Out
Ø System Set-up, set, save and recall system set-up, machine set-up and Macro key set-

up.
Ø Displays the Track Arming Layout and Status.
Ø Follows Selected machine, Enabled machine or System as selected by user.
Ø Displays all available tracks and selected bank
Ø Set, Save, and Load System record key layout.

• Q2Image1

Ø Store a list of cue points with captured video images.
Ø Select and locate to any image.

• ADR-Taker1

Ø Generate and download EDL and Taker lists 

• EDL-Link2

Ø Import and download EDL files, Taker Files, Cue Lists 

? Existing software is currently being updated to work with the new system and will be available soon.
1
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• Remote Control
Ø Windows machine control interface
Ø Low cost external USB jog and shuttle controller (Contour Shuttle-Pro).

• Third party applications
Ø OEM customers can integrate their products via the server to multi machine control.

The current version of the server is designed to control multiple machines via CB Electronics Xmc
protocol.

Displaying this pdf from System Display: Both English and French versions of this pdf are
installed with the program. Provided your computer has acrobat installed you can display either by
selecting Help/Manual from the Master display menu bar.
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1.0 CB System display

The ‘CB System Display’ gives the user the ability to view current information about the system.
The System Display consists of two main windows,:

• Master Display
• Full System Display

The system display is designed to run alongside your application for example Console automation or
DAW. The master display is a ‘stay on top’ window that is sizeable and is made up of user selectable
panels. The Full System Display displays information on the individual machines. 

1.1.1 Master Display
The Master display consists of multiple panels which the user may combine to suit his application.

1.1.2 Master Display main panel with system macro’s:

1.1.3 Main Panel
• Master Position The size of the master position is used to define the size of this window
• System Lock LED Indicates when all machines in the current selected group are locked.
• System Record LED Indicates if any machine in the current selected group is in record.

1.1.4 Optional Panels 
• System Macros: Visible by default, although any macro command may be selected for these

buttons it is assumed that display enable/disable and desktop select keys will be used.
Checkout the MinMax key!

• Track Arming: Current selected track arm keys, selectable by machine or system track
arming.

• Macro’s: General macro keys normally used for machine control. The number of rows and
keys per row is set in Preferences.

• Machine Select: Machine select keys
• Machine Control: Transport keys, Record In and Record Out
• Locate: Locate keys, Right Click to capture a timecode value (displayed on key) Left Click

to locate current selected machine, or entry code value using the Key pad windows. The
number of rows and keys per row and the selection by row between capture or direct entry is
set in Preferences.

The number of machine keys displayed on both the track arm panel and the machine select panel
is defined by the system attached.
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2.0 Master Display with all panels active

2.1.1 Selecting the panels that you want displayed
There are several ways of enabling panels

• By right clicking anywhere on the Main Panel a popup menu is displayed, the view panel on
the popup menu enables individual panels.

• The system macro keys may be programmed to enable individual panels.
• The MinMax system macro key will enable/disable all selected panels except the system

macro panel.
• The Master Display view menu, this is the only way of selecting

the System Macro panel.

2.1.2 Displaying the Master Display Status Bar and Menu
The menu and status bar at the top of the display will auto-hide when not
revealed by the mouse. Move the mouse slowly up the top of the master
display to reveal..

2.1.3 How to Right Click on a Touch Screen:
Touch and hold on the screen, the response time is set in Preferences | Master Display | Response.
On some touch screens this a standard and the response time set by the touch screen software.
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2.2 Saving a screen image:

If you have a problem or if you have a question it is possible to save a screen image directly from the
program. The image generated is save as screenimage.jpeg as saved in the same directory as your
trackmaps. 
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3.0 PopUp Menu:

The popup menu provides a simple means to
access most of the settings of System Display.
It can be opened by right clicking on the main
panel of the Master Display. Right Clicking in
the title panel of the Details display will also
open the popup menu.

• View: Show or Hide individual panels,
use Details to show/hide Full System
Display

• TrackMap: Load/Save the current system track map to File.
• Offsets: Load/Save all machine Offsets to File.
• Size: Master Display size, use Page Up and Page Down to make fine adjustments
• Preferences: Open System Display preferences menu
• Desktop: Open Desktop Menu.
• Setup: Open set-up file on CB Synchroniser.
• Manuals: Select and display pdf manuals 

3.1 TrackMap: Track Arming Control
and indication
This panel follows the track arming keys in the
system. This panel displays the total number of
tracks available and the current selected bank
(Used when machine has more tracks than the
controller has track arm keys.).

CB Electronics provides four types of track
arming keyboard track assignment as follows:

• System: Each individual record key
can be set to a different machine and track, used when access to multiple machines is
required. The system track map may be loaded and saved to disk.

• Follow Machine: The Record keys follow the current selected machine.
• Follow Record Enabled Machine: The record keys follow the last selected record enabled

machine
• Macro: Use macro selection buttons on keyboard or on the Master Display software to select

the machine or system arming display and control. The Track arm display is combined
with a machine select panel. The following information is displayed:

• The currently displayed machine or System Track Arming
• A machine selection panel
• The available record tracks.
• Current selected bank

Note: This illustration shows a warning message. The Warning message is removed by any
command or by clicking on the warning message.
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3.1.1 Right Click on the Arm Key to set the track arm mode.
The Banks key allow you to set the number of record keys in a
bank and the number of record banks.

Right clicking on the individual
machine buttons a machine setup
menu is displayed that allows you
to enable/disable record, set as
master, set offset an access
machine specific record
parameters.

The Offset and Tracks keys open
the appropriate menu.

Auto Offset will calculate the offset at the current relative
positions of master and slave.

3.2 Macro Keys
Two macro key panels are fitted, the system and user panels. The system macro key panel is a single
row of macros under the Master timecode display and is always visible. The user macro key panel
has up to three rows of macro keys and may be turned on and of by the user.

The macro's for both panels are selected from the same
list in the same way. Right click (On push and hold) on
the macro key. The selFunction  form is displayed. Select
the macro  that you want and click on OK.

If the Selfunction panel is not displayed then check that
the macro lock is not enabled in preferences.

3.3 Preferences
The preferences display is used to set user
preferences for the Master Display and the System
Details. These preferences are saved and recalled
with the Desktop settings. 

There are two pages on the preference menu,
Master Display and System Details.
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3.4 Master Display Preferences
• Frames in Play
• Machine Control Lable

(Enable/Disable)
•
• Timecode Display font size
• Response (Touch & Hold right click)
• System Keys per Row
• Macro Keys Number of  Rows
• Macro Keys Keys per Row
• Locate Keys Number of Rows
• Locate Keys per Rows
• Locate Entry Rows (Right Click to Set

Locate Point/Capture current position) 
• Locate Entry Lock
• Macro Key Lock
• Password Protection 
• Record Link

The size of the Master Display is set by the user, this allows the display size to be tailored to fit
different resolution screens. Because of this the number of macro/locate keys per row can be set by
the user to suit their application and display resolution.

3.4.1 Locate Keys
There are two types of locate keys
1. Locate to preset value: used to locate standard start times (i.e.: 09:59:58:00)
2. Capture and Locate Keys: used as temporary stores (Right Click to capture current master

Timecode).

3.4.2 Password
The Password is used to lock user access to both user preferences and system setup. See SR-User
manual for password.

3.4.3 Record Link
When enabled the Record machine select keys will select machine when set to Follow machine or
Follow Enabled. If not then a error flag will be generated.
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3.4.4 System Detail Preferences
• Frames in Play
• Always Show Standard
• Show Offset/Sync Point
• Show Record In time
• Show Record Out time
• Individual Machine Display Enable

The System Detail display is not user
sizeable, however the user may vary the
width of the display by turning on and off
different elements of the display.

The hight of the display may be adjusted
by enabling/disabling the machines. 

3.5 Defining Different display configurations using the Desktop Settings
Working with different
applications or different users
requires multiple set-ups or
desktops. By selecting the
required screen position, open
panels, and size and then saving
each desktop under a different
name the users may then select
the appropriate desktop from the
desktop list or by key.
 Desktop settings can be
password protected so that they can be updated by the user only. Using a simple password will also
prevent accidental update.

3.6 System Details

The System Details may be enabled and disabled as required via the Master Display View menu.
Once enabled clicking on the master display will show the view menu. As with all CB systems
machine recognition, automatic set-up and record track arming come as standard.
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The above display shows the Generator as master in play with the DA-88 and MC-1 as slaves.  The
DA-88 and MC-1 are both armed and recording. The MX2424 is a free machine in stop.

3.6.1 System Details Menu
The System Details menu is revealed as you move the cursor over the top of the System Details
display. Note: these functions are also available from the pop-up
display. The following menus are provided:-

Options
• Preferences: Master Display, System Details.
• Desktop Settings: Multiple user/job set-ups.
• System Setup: SR/MR/RM Setup.

3.6.2 Offset 
• Refresh: Load Offsets from default offset file
• Save: Save offsets to current file.
• Load From: Load offsets from user selected file
• Save As: Save offsets to user specified file.
• Clear All: Reset All offsets to zero and disable chase.

Note: Every time the Offsets are changed the default offset file is
updated

3.6.3 Help
• About: Show Registration screen
• CBServer Manual: Open PDF of this manual
• All Manuals: Select from available manuals

. .

In addition to its display capabilities, you can currently perform the following actions:
• Set Offsets
• Set Sync points (System automatically recalculates the new offsets)
• Record enable
• Chase enable
• Select the system master
• Set Record In and Out Points
• Record Track arming.

3.6.4 Machine selection
Left clicking on a machine name or machine position in the details display will select that machine.

Right clicking will bring up the menu as shown. This allows you to select any
machine as a master, chase enable or record enable.

Set Alias  (Alternative Name) allows you to name the machine on the selected
port.  Reset Alias allows you to clear any alias selected. Loading a machine
definition file will also set the alias.
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3.6.5 Offset Display (Offset, Sync point, Difference)
The offset display may be switched between, Offset, Sync Point, or Difference.

• Offset allows direct entry or increment/decrement of offset
• Sync Point allows offset calculation by specifying a sync points for each machine in turn.
• Difference allows monitoring of system performance.

3.6.6 Individual Track Arming Displays
Click on the track arming area of the full system display to open a track arm window for the selected
machine. Note that the machine ID determines the number of tracks displayed. Individual machine
record enable and record On/Off are also available on the track arm panels.

The track-arming window includes Record
Enable, track arming and record on/off as
‘Illuminated Switches’.

Click on the track arming Switches to
enable/disable individual tracks.

Click ON or OFF to control record on individual
machines.

Display up to 48 Digital tracks plus analogue
audio and video.

3.6.7 System Set-up
Individual user/project set-ups can be generated, saved and loaded at any time. 

3.6.8 Machine Set-up
Individual machine settings may be saved, the filename selected is used as an ‘Alias’ name that may
be used in place of the machine name. For instance Radar-1 reports that it is a BVU-950; set up the
record and locate parameters for the Radar, then save the file as Radar-1. This file may be then
loaded at any time.

3.6.9 Macro Set-up
Individual/project keyboard macro layouts may be saved and loaded at any time.
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4.0 Cue List 

The cue list is designed to work work with cues added in real
time and to import cues from an imported EDL.

One of the problems when importing cues from an EDL is the
large number of edits in modern productions. The star '*'
column allows the user to mark the important cues. The user
then has the option of locating either all cues or only marked
cues.

When System display is started the last cue list used will
loaded.

4.1 Previous/Next with Picture
With the advent of hard disk video it is now possible to move
around the cue list with instant picture. This feature may be
disabled when using tape or film.

4.2 Follow Timecode
The cue list pointer may be set to follow timecode [Follow],
when enabled cue locate or locate previous will always locate
the start of the current section.

4.3 The File Menu

4.3.1 New

Clears the current cue list.

4.3.2 Load, Save Cue List
The cue list is saved in a proprietary format but may be imported from
standard edl files..

4.3.3 Import EDL
Use to import standard EDL files, the EDL edit number becomes the cue number and the EDL
Record in will be used as the cue point.

4.4 The View Menu
The user display is modified by the View menu.

• Columns may be enabled and disabled
• In and Out  capture keys may be displayed.
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4.5 The Tools Menu

4.5.1 Renumber
Incremental renumber from cursor position

4.5.2 Conform
Chose a starting cue, enter an new timecode value.
The selected cue value will be updated and all
following cues modified by the difference

4.5.3 Delete Cue(s)
Mark a cue or range of cues and delete, Short-cut: 'Delete' key.

4.6 The Options Menu
The options menu determines the actions as you move around the cue
list.

4.6.1 Prev+Next with Locate
When using a Hard Disk or DVD video source this options gives instant
pictures as you scan through the cue list.

4.6.2 Select with Locate
When enabled clicking on any locate will issue a locate to the selected cue.

4.6.3 Prev/Next * Only
When enabled only the cues marked with a '*' are selected.

4.7 The Cue List Pop-up Menu
Right Click on the appropriate column to open.

4.7.1 Sort Cue list
Right Click on the column that you want as the sort index, and select sort ascending/descending.

4.8 Double Click on cue
This will always locate to the selected cue.

4.9 CB SR/MR Keyboards
The following standard keys will interact with the cue list. See the next section for details on special
CBServer Macro's.

4.10  ID<<, ID>>
These keyboard keys are linked to the cue list allowing the use to move around the cue list from the
remote keyboard.
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4.11 Mark
This key will add a cue at the current position to the cue list.
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5.0 Linking CB Keyboard Macros to CBServer

All CB Keyboards (SR-4,SR-424...) incorporate macro keys, the latest version of CBServer can be
controller by the keyboard by setting appropriate macro's as follows:

Macro
Number

Macro Function Shift Function

1 Details: Show/Hide full display
2 CueList: Show/Hide Cue List
3 MinMax: Minimise/Maximise Display

11 Star: Add/Remove Star Enable/Disable * locate
12 Prev Goto Previous Cue
13 Next: Goto Next Cue
14 Locate: Goto Current cue
15 Follow: Enable/Disable CueList code follow
16 Mark In
17 Mark Out
18 Increment Current In point
19 Decrement Current In Point
20 Delete Current Cue
21 Get Cue List
22 Select Next Cue
23 Select Previous Cue
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6.0 CB Server software

At the heart of the system is the CB Server.

The CB Server is a new software product from CB Electronics that may be used with an RM-6 or
any SR/MR system with suitable software. The server is designed to allow multiple windows
applications to access and control machines in the studio via a single port on a Windows PC.

Connection is via the RS-232 port (Com x) using a self-powered inline RS-232/422 converter. This
will be replaced by a new USB to RS422 converter currently in development.

The server has been designed to work with 3rd-party software, providing advanced machine control
capabilities through a simple DLL interface.  It offers vastly reduced development time, as there is
no need to cope with the intricacies of specific machines. An OEM development package is available
with full information, examples and source code.

Although the server is powerful, it is also very discrete. During
normal operation, the only visible evidence that the server is
operational is a CB icon in the system tray. Right-Click the
icon for the context menu or Left-click to show/hide the server
dialogue directly.

You can view the current status of the server, change the COM port, and view the client applications
currently connected to the server.

  
In normal operation the server is an icon in the start bar or tray. Clicking on this will display
the server. The Server has three user screens

Status: the main setup and status screen

The Status indicates the current status either
1) No data received from device, No connection

between CB Server and serial port, check
Enable/Disable  and com port number.

2) No cyclic data, check that the CB Server is
assigned to the correct output port, use the
change key if not. The serial port is connected
to port F/Keyboard on the RM-6 and that the
cable is made correctly.

3) Controller has no video syncs, check the
video sync connection to the RM-6.

4) OK, Serial communications and Video Syncs
are correct.

Protocol: the CB Server may be setup for Xmc multi-machine protocol or standard Sony P2
Protocol.

Enable Coms:  Enable and disable serial port.

Monitor: Enable/Disable Monitor Display
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About: Show Registration screen

Terminate: Terminate CB Server and Client programmes

Hide: Hide the CB Server screen, the Icon in the ‘Tray’ may be clicked to display the CB Server. 

6.1.1 Clients
This screen indicates which client programs
are currently connected to the server

6.1.2 Run Clients
This  screen allows you to browse and select
client programs, run client programs and select
which client programs to run automatically
with the server. When you exit the server
program it will automatically exit from any
client programs.

The Run Clients screen shown indicates that
the SysDisp.exe is active and will be run at
start-up.

AdrTaker and SettingsDemo are two other
programs that may be run by clicking on their
names.
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